
MONTANA
STATE

This "cover" page added by the Internet Archive for formatting purposes





4.028
3inv
c. 98

AH
II I II I I I riillll

ucbcmucr i;ido

llcwajnews
A NEWSLETTER DEDICATED TO INFORMATION TECHNOLOGY IN THE STATE OF MONTANA

New Look for Montana Online

state Government on the World Wide Web JAN 1

Govoii
Irifn, Hidi. Tw

Sate L^.-MT y::-:

Tourram & Rvcrvotion
Triwl. Viiiw Inf(fm*tor,, Loiw*
itJt^ I'Vi I'sfj .

?ii-»a :-lj.tnJ

Loc il Corr riiUyv

Montana Online, Montana's homepage on the Internet, is ag^^ ^, -^ _^
find more information about Montana. The homepagcn^iftpiiasizeS'

gov'ernment information and there are also links to Montana informa-

tion (such as weather) that are more general in nature.

More than twenty-seven agencies are accessible through Montana Online,

as are universities and K-12 schools. The web page is a great source of

travel and tourism information. There is also a direct link to legislative

information from the Montana
r \ '

Online homepage. Ji'ilyiRilllU^OllJrily
Montana Online features a Mon-

tana picture that changes weekly.

The search capability of the page

is easy to use to find just the

information needed.

Here is a list of just some of the

government information acces-

sible via the Internet:

Tax help

Professional licensing

Year 2000 compliance

Purchasing bids

Job openings

Are you legalP

Employmsnt
EntJoymiciSfT.'.cg:. Smt

History & Culture

Mooanj Art! C ftuacil

Search State orUontana

I I

Visit us at www.state.mt.us

Public assistance

State parks

MTPRRIME
Governor's budget

Local government web pages

Software piracy effects all of us. It is legally defined as the criminal act of

making or distributing for financial gain, an unauthorized copy of a copy-

righted software product. Worldwide, the use of illegal software costs more

than $11.4 billion annually — $2.7 billion in the United States alone. In

1996, proliferation of illegal software in the United States resulted in the

loss of 130,000 jobs, $5.3 million in lost wages and nearly $1 billion in lost

tax revenue.

In early October, the US Congress passed HR 2281 that protects online

copyrighted material. With Internet use on the rise, software companies are

making their products available online. This makes them more vulnerable

to software piracy. This newly enacted law proposes stiff penalties for un-

authorized distribution of software and other copyrighted materials.
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How much unauthorized software is on your system?

There are specific state standards regarding the use of

computer software. A list of approved software is

available at http://www.state.mt.us/isd/techinfo/

software.htm. If there is a piece of software that you

need to use that is not on the list of the state standards,

you may request to be able to purchase it. Once approved,

your network administrator and purchasing agent will

work with you to purchase and install the software.

Installation of software without the guidance of your

agency network administrator can affect the configura-

tion of the PC in question and jeopardize the integrity

of the entire network. Therefore, it is best to work with

your network administrator to ensure the software is

installed correctiy.

If you are going to download software from the Internet,

be sure the site you are downloading from is legitimate.

(It's also a good idea to scan anything you download for

viruses.) Some sites claim to be resellers of software,

but they are actually selling pirated copies of the soft-

ware. Also, check with your network administrator be-

fore downloading any software. They may already have

a legitimate copy that will save you time in

downloading, as well as prevent unneeded stress

on the network.

For more information regarding pirated software,

contact Lynne Pizzini, ISD Network Security Officer

at 444-4510, ZIP!/Outiook or via e-mail at lpizzini@

state.mt.us.

Calendar of Events

December

mm Information Technology Managers

Council (ITMC), 8:30-10:30am,

Rm HI, Metcalf Bldg.

^M Information Technology Advisory

Council (ITAC), 8:30am-12pm,

Rm 111, Metcalf Bldg.

^^ Public Safety Communications Council,

9am-3pm, Rm 160, Mitchell Bldg.

January

^m Information Technology Managers

Council (ITMC) 8:30-10:30am,

Rm 111, Metcalf Bldg.

Hew E-Mail Going Production!

On your mark...

After a successful pilot phase, state agencies are con-

verting to the new Microsoft Oudook e-mail standard.

As of this publication date, over 3300 new user mail-

boxes have been created on the Exchange server and

are in production on PCs running the Oudook client

software.

The E-Mail Implementation Team has plotted out a very

aggressive deployment schedule, averaging 1000 mail-

boxes each month.

Conversion will be complete July 1, 1999.

Get set-

Before an agency makes the conversion, their key

deployment staff meets with e-mail team members to

go over migration details, agency readiness, documenta-

tion, training, installation concerns and scheduling. From

that point on, agency technical staff are asked

to participate in a weekly problem-and-change

style meeting direcdy after the Friday Net-

work Managers Group meeting. This

provides a forum for agency staff to ask

questions and helps all parties involved stay on

track with the process. Agency staff is responsible

for the client installation on all PCs, a huge project.

Training for the Oudook client is mandatory and the cost

is covered through the Data Network Connectivity rate.

The state has arrangements for out of town training in

Billings, Havre, Glendive, Kalispell, Missoula, Butte, and

Great Falls. Instructors from Billings and Helena also

have access to a portable training lab that can be taken

to additional locations in the state if needed.

Go!

Once your conversion date is reached, there is no going

back! Your old e-mail will be disabled and you will not

be able to send and receive mail any other way than

through Oudook (Internet mail will come to your Out-

look Inbox).

Questions?

Agency's conversion questions should be directed to your

IT Manager. Overall project questions can be directed

to Wendy Wheeler of the Policy, Development and

Customer Relations Bureau at 444-2856, ZIP!/Oudook

or e-mail at wwheeler@state.mt.us.
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Capitol Complex lANs, Part 2

Iast month's article covered the basics of LAN
(Local Area Network) technology in the Capitol

Complex environment. This month will center on

the future of the Capitol Fiber Backbone (CFB).

Typical of most large organizations, the State of Mon-

tana has experienced an evolution in computing styles

and a significant increase in the number of end users.

The use of computer technology in government has

become a way of life for almost every state employee.

The net result of these changes is a significant growth

in the utilization of the CFB.

More Bandwidth Needed

The traditional mainframe centric applications and the

legacy terminal/computer environment is being rapidly

replaced by Graphic User Interfaces (GUI), client/server

applications, increased e-mail, more imaging, and the

implementation of multiple Client/Server PeopleSoft

applications. While these applications are much more

end-user friendly, they are notorious bandwidth 'hogs'.

The result of the application evolution and increased

usage is that the load on the campus backbone has been

steadily increasing and will increase dramatically as the

new e-mail and MT PRRIME (PeopleSoft) applications

are brought into production. This accelerated demand

requires higher bandwidth and further segmentation of

the campus backbone in order to continue to provide

the appropriate levels of service to our end users.

From last month's article, we know the CFB was de-

signed and built upon a fiber optic cable technology uti-

lizing IBM's Token Ring architecture. Fiber was selected

over copper because cable distance limitations were re-

moved and because fiber has an almost unlimited band-

width growth potential. By selecting fiber, ISD was as-

sured the expensive investment in physical plant (trench-

ing, conduit, fiber, etc.) would have a very long life span.

Fiber provided immediate high-speed LAN connectiv-

ity and the ability to upgrade bandwidth as technology

provided the speedier connectivity hardware. As ex-

pected, hardware technology has made major strides

since ISD built the CFB.

New Technology

In recent years several high speed technologies have

emerged for carryingLAN traffic - Asynchronous Trans-

fer Mode (ATM) (155megabit), fast Ethernet (100 mega-

bit) and now High Speed Token Ring (HSTR) (100 mega-

bit). Two years ago ATM was the preferred technology

for high bandwidth LANs. While still an excellent tech-

nology for Wide Area Networks integrating voice, video

and data applications, ATM currentiy is not considered

the best choice for campus backbone networks. Fast

Ethernet is the current hot technology. It is hot for three

reasons.

It is fast

It enjoys tremendous industry support

It is inexpensive relative to Token Ring

Considering the State's large investment in Token Ring,

HSTR appears to offer lots of promise, but the technol-

ogy is in its infancy and is not a viable technology for

upgrading the CFB.

For the past year, ISD personnel have been working with

our vendors searching for the best hardware/software

architecture for upgrading the CFB. Our goals were two-

fold.

Increase the bandwidth

Provide the capability to support Ethernet traffic

on the CFB

The technology of choice at the time was ATM, so ISD

examined and thoroughly tested the ATM technology.

The ATM technology proved to be extremely complex

and difficult to install, configure and operate. While the

technology worked very well (passing all of our tests),

the ATM tests overwhelmingly convinced ISD that we

had no desire to master an entirely new and extremely

complex network technology. This left fast Ethernet and

HSTR as the two viable technologies for upgrading the

CFB. Since the State of Montana is predominantiy a

Token Ring environment, we were faced with a dilemma.

Because HSTR was so new, it was not seriously consid-

ered as an option. That left ISD with Fast Ethernet,

which initially did not appear to offer much promise but

the industry wide acceptance of the technology caused

ISD to take a closer look.

After numerous and extensive discussions and design

meetings between ISD and our vendors, ISD feels con-

fident that we have found a flexible, more cost-effective

and comprehensive solution for upgrading the backbone.

The second generation CFB will be built on a high speed

switched fast Ether channel technology from CISCO
Systems.

>
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The one constant during our discussions with all the

vendors and consultants was LAN switching. Everyone

unanimously agreed that future high speed (greater than

100 megabit) LAN technology needs to be switched.

This technology has been adopted by ISD for the future

of the CFB.

Changes Ahead

ISD has undertaken an upgrade project for moving the

CFB from the current 16 megabit-transport speed to

200 megabit. The architecmre will give us a growth po-

tential of up to 800 megabit for the backbone. The plan

is to build a fully redundant core network on high speed

switching platforms in three separate buildings. Since

capitol complex buildings are connected via high-speed

fiber, the three buildings were selected to house the core

hardware based on the physical layout of the existing

fiber. This design will provide

the maximum growth potential

and stability throughout the

capitol complex LAN.

Existing Token RingLANs will

be connected to the CFB via

high-speed (200 megabit) up-

links. The core network will

have capabilities to transport

Token Ring, Ethernet and

ATM if necessary.

ISD and vendor personnel will

begin installing the hardware

upgrades over the next few

months. The new CFB will

coexist with our present environment, so the modifica-

tions required to the campus backbone for implementa-

tion of this design, will have minimal service disruption

to the users and will advantageously position the State

for increased growth and functionality. The flexibility

of the solution allows the State to make additional

modifications as required and to protect the investment

made in planning, people, equipment, software, and

implementation.

For more information contact Dennis Sheline of the

Telecommunications Operations Bureau at 444-2869,

ZIP!/Oudook or e-mail at dsheline@state.mt.us.

The flexibility of

the solution allows

the State to make

additional modifi-

cations as required

and to protect the

investment made

in planning,

people, equipment,

software, and

implementation.

9-1-1 Centers Compliance -

Americans with Disabilities Act

Dialing 9-1-1 is a familiar and effective way to find

help in an emergency. The Americans with

Disabilities Act (ADA) requires all Public Safety

Answering Points (PSAPs) to provide direct, equal ac-

cess to their services for people with disabilities who
use Teletypewriters (TTYs), which are also known as

Telecommunications Devices for the Deaf (TDDs).

Mr. Ryan Warren, of the United States Department of

Justice, was a speaker at the 1998 APCO Public Safety

Communications Technology Conference in September.

Some of the issues he addressed include:

I'lY users must have the same direct equal access

to call-taking positions on 9-1-1 lines. A PSAP can-

not require TTY users to call a seven-digit number

when voice callers may dial the more familiar 9-1-1.

• Equal access means that telephone emergency

services provided for TTY users is as effective in

response time, response quahty, and hours of

operation as for voice calls. TTY users must be

offered all the same features, such as automatic

number identification, and automatic locarion

identification.

Direct access means PSAPS can directly receive i'lY

calls without relying on an outside relay service or

third-party service. PSAPs cannot rely on State re-

lay services to answer emergency calls from persons

who are deaf, hard of hearing or who have speech

impairments. Equal access to 9-1-1 services must

be provided.

To afford equal access to TTY users, every call-tak-

ing position within a PSAP must have TTY or i'l Y
compatible equipment. PSAPs must have systems

that enable TTY calls to be handled as proper,

prompt and reliable as voice calls.

The U.S. Department of Justice requires a llY query

of all sOent calls received on 9-1-1 Unes.

PSAPs must train call takers in the use of TTY equip-

ment and to effectively recognize and process i'l V calls.

Call takers must have information about communica-

tion protocol for individuals who are deaf or hard of

hearing, or who have speech impairments. The ADA
does not specify training requirements, but the Depart-

ment of Justice believes training should be mandatory

for all personnel who handle TTY calls. PSAPs should

require or offer refresher training every sLx months, or
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as often as they require or offer training for voices calls.

To ensure effective training, PSAPs may consult the

Emergency Access Self-Evaluation program (EASE)

manual, published by the Telecommunications for the

Deaf under a Department of Justice grant. The EASE
manual was reviewed by the Department of Justice, and

can be obtained for a fee. CaU TDI at 301-589-3786

(voice), 301-589-3006 (TTY), or 301-589-3797 (FAX).

The ADA regulations also require entities to maintain

their accessibility features and equipment in working

condition. Equal access obligates PSAPs to implement

equally effective procedures for maintenance and backup

of TT\^ equipment as provided for voice telephone

equipment.

For information on the Americans with Disabilities Act,

or questions about your 9-1-1 PSAP compliance,

contact the U.S. Department of Justice, Civil Rights

Division, Disability Rights Section on their ADA infor-

mation line at 800-514-0301 (voice) or 800-514-0383

(TTY). You may also access their home page at

http://www.usdoj.gov/crt/ada/adahoml.htni.

For more information contact Surry Latham of the

Policy, Development & Customer Relations Bureau at

444-2420, ZIP!/Outlook or e-mail at slatham@
state.mt.us.

Year 2000 Progress Report

State agencies are bringing systems into Year 2000

(Y2K) compliance at an improved rate. As of

November 2, 1998, 341 of the 708 systems

monitored were Year 2000 compliant (roughly 48%).

This is more than 50 systems ahead of the number

predicted by this date.

Agencies have analyzed and prioritized the 708 systems

on a High (30%), Medium (30%), Low (40%) hierarchy

Each group is slighdy ahead of schedule. Perseverance

will hopefully see us through to the next Millennium.

State of Montana
Telecommunications Network

We have a pretty good handle on our State computer

systems, but what about our networks and telephones?

Carl Hotvedt, Bureau Chief of the Telecommunications

Operations Bureau at ISD recendy reported on the sta-

tus of the State's infrastructure.

According to Carl, many network issues in relation to

Y2K have been addressed and tested. The lOS (soft-

341 Of 708

Systems

ware) on all routers and switches is being upgraded to

the Y2K compliant version 11.2. These updates should

be completed this fall. All frame-relay access devices are

currentiy Y2K compliant.

With the implementation of the new e-mail system,

Microsoft Exchange, all gateway computers will be

removed. If the Exchange deployment fails to meet its

deadline of July 1, 1999, all remaining gateways will have

their BIOS upgraded and will then be Y2K compliant.

The current version of NetWare, 4.11, has been tested

for compliance. Earlier versions of NetWare have some

Y2K issues. There is a Y2K test tree that contains four

servers. Three of the servers are running NetWare and

one is runningNT 4.0. NT is com-

pliant with some patches installed.

The Seagate backup software has

also been tested in this environ-

ment and is Y2K compliant.

There is some concern over external connections to the

state network such as local governments, contractors and

the Federal government. It may be necessary to discon-

nect these entities if they are causing a problem when

January 1, 2000 arrives.

Regulated Utilities

The Montana Public Service Commission is deeply con-

cerned over the Year 2000 issue and the challenges it

poses for Montana's public utilities (i.e. MPC, US West,

etc.). The PSC has issued a Notice of Inquiry to all regu-

lated utilities (co-op's and municipal utilities are not regu-

lated by the PSC) asking for specific information on how

each utility is preparing for the Year 2000. Most responses

have been received by the PSC and a preliminary report

has been drafted. According to the report,

Most utilities are aware of the Y2K problem

Most utilities project a mid-1999

Year 2000 compliance date

Most utilities have notified their

customers regarding the Year 2000 issue

Most utilities have a Year 2000 plan

The PSC will continue to request quarterly status reports

to insure that all regulated utilities are adequately

prepared for the Year 2000.

For more information on the Year 2000 problem,

contact G. Scott Lockwood of the Policy, Development

& Customer Relations Bureau at 444-2655, ZIP!/Out-

look, or e-mail at slockwood(5)state.mt.us.
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Care of Computer Equipment

Computer equipment, including hardware items such as

CPU's (central processing units), monitors, keyboards,

mice, modems, printers and other telecommunications

devices, all need proper care and attention. Each user is

responsible for having knowledge of the State's policies

concerning security and care for computer equipment.

The State's policies indicate the following:

Your network administrator must be contacted before

moving your desktop computer to a new location to

be sure that the change will not affect the computer's

configuration. If you are moving to a new room, the

network administrator will be able to verify if network

wiring is in place and order new wiring if needed.

Care should be taken when positioning a computer in

the work environment. Computers should be well

ventilated and they should not be put in a position

that covers the vents or the fan.

Heaters, coffeepots, fans, radios,

and other electrical equipment

should be on a separate surge pro-

tector or oudet from the computer.

Use of other electrical equipment

on the same power strip, may cause

power surges which can damage

the computer.

Care should be taken when positioning the computer

electrical cords. The cords should not be positioned

near a heating element, under file cabinets, or in a

manner that may be a hazard for walking.

Computer screens and keyboards should be cleaned

periodically with a computer non-static cleaner. Foam

cleaner should not be used on computer components.

Workstations with unattended processes running on

them must have some type of screen saver with pass-

word protection or keyboard locking program enabled

on them. Users leaving their computers unattended

for 1 5 minutes or longer should either log off the net-

work or have the screen protected with a password.

Workstations and portable computers must be kept

out of sight and covered when stored in a vehicle.

Portable computers should be brought to room tem-

perature before using them. They should not be ex-

posed to extreme cold or heat for any length of time.

Portable computers must be transported as carry on

luggage when traveling by plane or bus.

If employees follow these simple rules, the computer

equipment that they use will last longer and have fewer

problems. For more information regarding user respon-

sibilities for computer equipment, refer to http://

www.state.mt.us/isd/policies/mdex.htm or contact

Lynne Pizzini, the Network Security Officer at 444-4510,

ZIP!/Oudook or e-mail at lpizzini@state.mt.us.

WinFrame Rate Reduction

In response to concerns about dialup remote access rates

arising out of the enterprise e-mail project, ISD has made

changes to its rate structure resulting in a reduction for

WinFrame users.

As of November 1, 1998, the following rates applied to

dialup access:

$5.00 Connection fee to access NetWare Connect,

ISD's modem pool (this rate did not change)

$5.00 Connection fee to access the WinFrame appli-

cation server (this rate was reduced by $5.00)

As of December 1, 1998, 1-800 service for dialup lines

will be discontinued. Agencies will be responsible for

any long distance charges incurred by their dialup staff.

ISD has several suggestions on how to make this change

easy on employees:

Use a credit card, available from the Telecommunica-

tions Operations Bureau by calling 444-2586

Set up an agency 1-800 number, also available from

the Telecommunications Operations Bureau by con-

tacting Pete Wiseman at 444-9655, ZIP!/Oudook or

e-mail at pwiseman@state.mt.us.

What is WinFrame?

WinFrame is a way of delivering application software

and access to agency network files via a server managed

by ISD. In addition, some agencies manage their own

WinFrame server. An employee with dialup capabilities

can use software such as Word and Excel via WinFrame,

as well as files from their own local area network. ISD is

also making a web-based version of Oudook available

through WinFrame.

Questions regarding the use of WinFrame may be

directed to Pete Wiseman (see the above contact

information). To register as a new WinFrame user, send

e-mail to WINFRAMEUSER, a mailbox handled by die

ISD Customer Support Center.



ENTERPRISE NEWS

MT PRRIME
Training

Training enrollment is now in fixll swing. Human Re-

source training is not that far away (February and March)

and eleven classes will be provided throughout the two

month period. Last month (November) each agency

training coordinator received enrollment training and

now has desktop access to the PeopleSoft enrollment

portion of the software. They

also received a list, specific

to their agency, of the individu-

als that were identified as

needing HR training.

If you plan to attend training

in any of the software classes:

ADA/Affirmative Action,

Central Benefits, Central Payroll, Competency Manage-

ment/Career Planning, Labor Reladons, Health and

Safety, Position Budgeting, Position/Employee Manage-

ment, Recruitment, Time and Labor, or Training Ad-

ministration, your Coordinator probably has already con-

tacted you. If you haven't been contacted, get in touch

with your Coordinator. The sooner you're enrolled, the

better chance you'll have of attending the session you

want.

Designated Agency Training

Coordinators:

Administration Joyce Yager

Agriculture Eileen Rose

Arts Council Carlene Layne

Board of Public Education Heidi Redman

Commerce Pam Watson

Consumer Counsel Celia Parian

Corrections Joe Williams/

Winnie Ore

Crime Control Nancy Petrie

Environmental Quality Judy Hanson

Fish, Wildlife & Parks Barbara Thomas

Governor's Office Mary Jo Murray

Higher Education Edwina Dale

Historical Society Sharon McCabe

Judiciary Lisa Smith

Justice Patti Forsness

Labor & Industry

Legislative Services

Livestock

Military' Affairs

Namral Resources

OPI
PERD
Political Practices

Public Health & Human Services

Public Services Regulation

Revenue

School for Deaf & Blind

Secretary of State

State Auditor

State Fund

State Library

Teachers Retirement

Transportation

Libbi Lovshin

CD Avery

Joni Wissinger

Virginia Cameron

Al Christianson

Kathy Fabiano

Roxanne Minnehan

Dulcy Hubbert

Sheri Vukasin

Laura Calkin

Tonya Thompson

BiU Sykes

Gary Managhan

John Huth

Lynn Donnelly

Kris Schmitz

Tammy Rau

Marjorie Blewett

PeopleSoft will result in change

The way we do business in state government is chang-

ing. In some areas, change will be slight, others it will be

significant. Many end users are now migrating to the

Microsoft environment. We are changing the way we
manage human resources, financials and the budget — a

completely new software system. Planning the change

is not only wise; it's necessary to stay abreast of the

ever-changing business environment.

More big changes are on the way. As soon as we imple-

ment Version 6, we'll be working on the next upgrade.

What we're seeing is not only the result of reaction to

the outside world or the Year 2000 issues. We're seeing

an ever-increasing rate of change that will allow us

to capitalize on oppormnities for improved business

processes. As a public organization, we're trying to

install a "world class" business environment. We really

don't have much of a choice. We simply won't be able to

fiinction with the rest of the world if we don't adapt.

For more information contact Anita Varone of

MTPRRIME at 444-2013, ZIP!/Oudook or e-mail at

avarone(^state.mt.us.
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Montana's New Legislative Information

System Available Via The Internet

About 150 state employees recently attended demon-

strations on the Legislative Automated Workflow

System (LAWS) and also on the new "State Agency

Bill Tracking System", which provides a customized

interface to the LAWS database for state agency use.

Both systems are now in operation.

The inquiry portion of the LAWS
system is available over the Internet,

and is free to anyone with Internet

access. The "Current Session Infor-

mation" home page is easily reached

from the "Montana Online" home

page, (http://www.state.mt.us),

by selecting the "1999 Legislative

Session" link under Hot Sites. Users

can bookmark favorite pages within the

site for quick access.

At least six agencies have already implemented the "State

Agency Bill Tracking System". For more information

on this system, contact Barry Fox of ISD at 444-5895.

This new Internet application allows users to access

online bill status information, committee hearing infor-

mation, agendas, etc., as well as the text of introduced

bills, amended bills, enrolled bills, and edited bill drafts.

The text of edited bill drafts was not available over the

Internet last session.

Advanced search features to help identify bills and bill

drafts of interest will also be available for Internet us-

ers. For example, users will be able to generate lists of

bills and bill drafts that meet specific criteria selected by

the user. These criteria can include one or more of the

following:

Requester of a bill draft

Primary sponsor of a bill

Drafter of a bill

Subject assigned to a bill

Current status of a bill

Other criteria

Internet users who wish to track specific legislation can

sign up for a special service called "preference list". This

free service went into effect on October 26, 1998, and

nearly 100 users signed up within the first two weeks.

This service allows users to create, modify, and save their

own bill/bill draft list files. Once a bill/bill draft list file

is created, the user can "click on a button" to generate a

report which lists the latest stams of each bill/bill draft

in the list, along with the bill or bill draft's short title and

primary sponsor/requester.

Applicants for this "preference list" service will be

required to mail in an application form to the Montana

Legislative Services Division. This form will be avail-

able from the Montana Legislative Branch LAWS
Internet page. Locate the form by clicking the Help link

at the bottom of any screen within the Current site,

then clicking the Preference List link, then the 'You

can learn more about the preference list feature here'

link. You are now in the 'How to Establish a LAWS
Preference List' help page. Scroll down until you see the

text 'First, read the terms of service below' Click this

link and read the terms of service information. If you

understand and agree to the terms, then click on and

print the Preference List service request form, which

immediately follows.

Fill out the form and foUow the directions to get the

form back to the Legislative Branch Main Office. The

Montana Legislative Branch will give users of this ser-

vice a userid and password in order to maintain their

own "preference list" files.

Bill text will be stored in WordPerfect 5.1 format on the

Internet and also on the State Bulletin Board System.

Note that WordPerfect 5.1 format is the same format

that was used for bill text during the 1997 session. The

latest version of each bill will also be stored in html

format for online viewing, similar to the 1 997 session.

Legislative information will also be made available to

users of the State Bulletin Board System (BBS). Note

that bill status information via the BBS is typically up-

dated only once a day while the Internet status informa-

tion will be online up-to-the-minute information. This

BBS data will include legislative reports, topically up-

dated once a day, as well as the text of introduced bills,

amended bills, enrolled bills, and edited bill drafts. The

text of edited bill drafts was not available over the BBS

last session. The BBS system has toll-free access within

the state of Montana.

For more information contact the Legislative Services

Division at 444-3064.
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Application Mining

The Case for CICS Client Server

Applications

There has been a lot of talk and movement lately to-

ward client/server applications. Does this mean that you

must throw out your existing CICS COBOL systems?

Leigh Compton of the IBM Dallas Systems Center pro-

vides the following definition: "a legacy system is one

that works!" I would like to present the case for reusing

those existing legacy applications while taking advan-

tage of "newer" technologies; i.e. GUIs, web browsers,

etc. The first and foremost consideration ought to be

the existing business processes. Legacy applications were

developed to meet the needs of a business process. If

that business process hasn't changed, then those appli-

cation models are still valid. However, there are limita-

tions to the 3270 interface that sometimes make it diffi-

cult to integrate data from those applications with PC
based office systems.

CICS has come a long way from the days of supporting

only the 3270 interface. Today, CICS can communicate

with any number of protocols. You can of course use

APPC over the SNA network. There is support for Re-

mote Procedure Calls via TCP/IP sockets programming.

CICS can directiy serve web pages to an Internet browser

via the CICS Web Interface. CICS can also distribute

itself out to the individual workstation via CICS Clients

technology and allow a program running on the PC to

call a native CICS program as if it were a local resource.

In a nutshell, CICS Is Client Server!

What benefit do you gain by utilizing CICS in this way,

as opposed to replacing entire systems with newer PC
based systems? Your core applications can be reused with

Utde or no changes. The

programming tools

available for developing

and debugging applica-

tions on mainframe

CICS can still be utilized.

There is no need for ex-

tensive retraining of ap-

plication programmers.

The CICS Client is a small piece of code that resides

on the local machine. The client allows applications

running on the PC to connect to a CICS server, either

running on NT, AIX, or MVS. As far as the client is

concerned it has a whole CICS system at its fingertips.

The server program doesn't care what client issued the

request; it treats it as if it were issued locally on the server.

This allows any program running on the workstation to

access CICS resources as if they were available on the

PC. Web browser access is handled similarly. CICS can

serve simple HTML forms or documents for display on

a web browser. Alternatively, installing the CICS client

on a dedicated web server machine gives that web server

access to CICS resources in much the same way.

CICS can also be distributed away from the mainframe

via products like IBM's TXSeries. TXSeries runs on

either AIX or NT and includes a full CICS server, web
server, and several other software components. The CICS

server code is a full-blown CICS system. Existing

COBOL applications running on CICS for MVS can be

ported to the new system, merely by recompiling the

existing source code with a native compiler for the tar-

get platform. This system still has full connectivity with

data sources residing on the mainframe while offloading

processing to alternative facilities. (Note: TXSeries is not

currendy installed. If you would like information on this

product, contact Don Grinsell. See contact info below).

If you are considering replacing your existing CICS

systems to allow better integration with office systems,

CICS Client technology can offer a more cost effective

solution. Additional information on the CICS Clients

can be found at http://www.software.ibm.com/ts/

cics/platforms/clients.

-( Internet )-

aEl Q Q n IZi
Windows 95, 98, NT

>.T-.---- ' r1 kTT- ..-.
'

.

'

,

Solans AIX

CICS
Client

d Si
CICS
Server

CICS OS/2 CICS/Win NT CICS/AIX UNIX CICS/400 ClCS/390

Note Not all clients can be directly attached to all serve's

For more information

contact Don Grinsell of

the Systems Support

Bureau at 444-2983,

ZIP!/Outiook or e-mail

at dgrinsell@state.mt.us.
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New Dataset Allocation Methods

& Software for S390 Customers

ISD
will be implementing Systems Managed Stor-

age (SMS) on the S390 Enterprise Server in the

Mitchell Building. This new technique will allow

ISD to maintain a high level of service, while holding

the cost of data storage at low levels. From a customer

view, no longer will they have to code a specific volume

identifier (volser) and hope that there will be enough

space on that volume to contain the data. The system

win manage space on the physical disk storage devices

and attempt to place datasets where there is enough space

to contain them.

We have converted some of the data volumes to SMS
and are achieving good results. The customers of the

Data Center have been able to continue their applica-

tions and jobs without changes.

Users may notice some differences, but don't be alarmed.

The most noticeable will be some new messages in the

allocation section of theJCL listing. Instead of the com-

mon lEFxxxx messages there will be IGDxxxx mes-

sages. As with the lEF messages, the IGD messages will

provide information on how datasets are allocated. An-

other aspect of this new allocation methodology will be

that specific volume requests will be ignored. Rather than

have the customer find space on a volume and then

request that the system allocate the dataset there, the

system will determine which storage pool the dataset

belongs in, and then find a volume that meets the

requirements of the dataset. SMS does this based on

rules which look at the dataset names, dataset names,

dataset type, size of the dataset, etc. and then applies

the rules to place the new dataset in a pool with datasets

of similar characteristics.

Users may also notice a message indicating the dataset

is being recalled. This may happen for a number of

reasons and should generally not take very long for the

recall request to be satisfied.

After all of our disk storage has been converted, there

are additional benefits. As the conversion progresses,

we will keep our customers informed of the new
features as they become available.

For more information contact Craig Smith of the Com-
puting Operations Bureau at 444-3458, ZIP!/Outiook

or e-mail at craigs@state.mt.us.

FTP on the S390 Server

Hints and Techniques

Each day millions of bytes of data flow between the

S390 FTP (File Transfer Protocol) server and clients

across the state. This process is generally easy and quick,

however, there are a few items to remember to make

this process even easier.

Directory Structure

If you have a logon account on a UNIX or AIX ma-

chine, your account usually has a default directory, i.e. /

usr/myaccount. At logon you generally are placed within

your directory. The S390 catalog structure can loosely

be compared with the UNIX directory structure. When
using FTP to connect to the S390, you are placed within

the catalog structure at your userid. If you logon with a

userid of "myaccount" then you would be able to do an

"Is" command and see all of the files that had

"myaccount" as their first node. The id "myaccount"

can be any userid that is valid on the S390 server. As-

suming you logon on the FTP on the S390 and have 3

files there. Doing an "Is" command, you might see

Is

tsolib.data

cnti.jcl

big.list

At this point, if you issued the "pwd" command it would

return that you are currendy in the myaccount working

directory.

If you issue a "cd .." command, to back out of the

directory structure one level and then do the "Is"

command things would look something like this:

cd..

Is

myaccount.tsolib.data

myaccount.cnti.jcl

myaccount.big.list

With this in mind, let's see what happens when we do a

'put' from our workstation to the S390 FTP server.

Issuing the following 'put' command without doing any

cd on either the workstation or the S390:

put myfile myfile

will get the following actual transmission:

The FTP client on the workstation gets the file /usr/

myaccount/myfile and transfers it to the S390 as

myaccount.myfile. Let's see what happens if we modify

the "put" command slightiy. Enter:
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put myfile 'johnacnt.myfile.data'

FTP send /usr/myaccount/myfile and tries to create a

S390 file called johnacnt.myfile.data.

Several things must have been already been done for the

transfer to complete successfiilly:

1. The first node "johnacnt" must have been setup as

a known firstnode within the catalog structure on

the S390.

2. You must have security authority to write to the file

"johnacnt.myfile.data".

3. There must be enough space to contain the file.

Changing S390 file parameters

What if the file you want to transfer has records that are

434 bytes in length? If you do nothing but enter a "put"

command you will find that your file's records are trun-

cated at 80 bytes. To rectify this modify the record length

that the S390 expects from the default of 80 to your

desired length, in this case 434.

To do this enter the following command:

site lred=434

This will allow your 434 byte records to be transferred

without truncation. Some client implementations do not

recognize the site command direcdy and need to be pref-

aced with the "quote" command:

quote site lrecl=434

You will need to experiment with your client to see if

"site" will work direcdy or if you must use the "quote"

command too.

The site command is quite powerful and will allow you

to change almost any of the parameters that you can

specify in S390 JCL.

Sysin Data

If you are trying to transmit data to the S390 and ex-

ecute a job on the S390 at the same time you might do

something similar to the following scenario.

A file on the workstation named mydata which looks

like the following:

//myjob job (accountingdata), userid, class=a

//stepl exec pgm=myprogram

//output dd dsn=myaccount.mydata,

// unit=tempstor,space=(trk,(l,l)),

// Irecl=100,recfm=fb,

(note: It is no longer necessary to code

"dcb=(Irecl=100,recfm=fb,. .
.)"

// disp=(new,cadg,delete)

//input dd *

mydata records 1 . .

.

mydata records 2...

mydata records 3...

mydata records 4. .

.

/*

Assuming you are logged on, the following commands

could be entered:

site filetype=jes

put mydata.jesjob

This would take the job in the file mydata and submit it

to the batch job processing queue on the S390. This

usually works well, however, I would suggest the fol-

lowing modification to this procedure.

I would create a separate file that contained the job JCL
call it myjob for this example.

Contents of myjob

//myjob job (accountingdata), class=a

exec pgm=myprogram

dd dsn=myaccount.mydata,

unit=tempstor,space=(trk,(l,l)),

lrecl=100,recfm=fl3,

disp=(new,cadg,delete)

dd dsn=myaccount.mydata.input,

disp=(old,delete,keep)

//stepl

//output

//

II

II

//input

II

/*
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Do two transfers:

site lred=100

put mydata 'myaccount.mydata.input'

When that completes do the second transfer:

site filetype=jes

put myjob.jesjob

This will allow you to not have to edit your datafile and

wrap the JCL statements around your data.

FTP Client Differences

Each client's FTP software will have differences in the

commands that it accepts. For example, most clients use

single quotes
'

', around the S390 filename. The AS/400

however requires double quotes " ".

For these differences you will need either a manual from

your workstation software vendor or someone experi-

enced with your FTP client.

ll
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Further Information on the S390 FTP

Server and Client

For further information on the S390 FTP process please

reference the IBM manual:

"TCP/IP V3R2 FOR MVS: USER'S GUIDE". This

manual is available online under the ISPF option "B"

and then under the 'TCP/IP V3R2 FOR MVS BOOK-
SHELF".

For more information contact Craig Smith of the Com-

puting Operations Bureau at 444-3458, ZIP!/Oudook

or e-mail at craigs@state.mt.us.

ITMC Meets Monthly

The Information Technology Managers Council

(ITMC) meets regularly on the first Wednesday

of each month to discuss state enterprise use of

technology. At the November meeting, the group heard

updates from the E-mail Implementation Team, Year

2000 progress and status and about legislative informa-

tion available for the upcoming session. In addition, the

group was informed about two new cooperative projects:

a network topology study, and a distributed IT resources

pilot project.

Minutes of the meeting are available on the ISD website

at www.state.mt.us/isd/groups/ITMC.

For more information on ITMC, contact

Wendy Wheeler of the Policy, Devel-

opment and Customer Relations

Bureau at 444-2856, ZIP!/Outiook or

e-mail at wwheeler@state.mt.us.

Oracle Reports v2.5

Oracle Reports is a tool for developing, displaying,

and printing production-quality reports. It is de-

signed for application developers who are familiar

with SQL and PL/SQL. Features include:

Data model and layout editors used in

creating the structures and formats

Object navigator to help navigate among

data and layout objects

Packaged functions for creating computations

Support for fonts, colors, and graphics •

Conditional printing capabilities

Fully-integrated Previewer for viewing

yovir report output

Context-sensitive online help system

When you first invoke Oracle Reports, it creates a new

report definition for you. The first window you see

is called the Object Navigator. The window displays a

comprehensive list of report objects. Using the Object

Navigator, you can easily navigate to all objects con-

tained within all currendy open reports.

To specify the data for a report, define a data model. A
data model is composed of some or all of the following

data definition objects: Queries, Groups, Columns,

Parameters, and Links.

Queries are SQL Select statements that retrieve data

from a standard database such as Oracle or DB2. You

can use any number of queries to select data from any

number of tables, located in any number of databases

on any number of machines.

Groups determine the hierarchy of the data appearing

in a report, and are used primarily to create breaks. Oracle

Reports automatically creates a group for each query,

but you are not limited to these defaults. Occasionally a

new group is necessary.

Columns contain the data values for a report. Default

report columns corresponding to the table columns

included in each query's Select list are automatically

created by Oracle Reports, and then each column is

placed in the group associated with the query that

selected the column.

Parameters are variables for your

report that enable you to change

selection criteria at runtime. Oracle

Reports automatically creates a set

of system parameters at runtime, but

you can create your own as well. You

create parameters to replace either single

literal values or entire expressions in any part of a query.

Data links establish parent-child relationships between

queries and groups via column-matching.

For more information on Oracle Reports, or any of the

Oracle applications, contact Steven St. John at 444-2910,

ZIP!/Oudook, or e-mail at sstjohn@state.mt.us or

Barry Fox at 444-5895, ZIP!/Outlook, or e-mail at

bfox@state.mt.us. Oracle database information can be

obtained by contacting Tony Noble at 444-2922,

ZIP!/Oudook, or e-mail at tnoble@state.mt.us or Tom
Rediske at 444-1593, ZIP!/Outlook, or e-mail at

trediske@state.mt.us.
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PowerPoint Fonts

Have you ever loaded a PowerPoint presentation from

your computer to another and found that it looks dif-

ferent? The culprit could be missing fonts. PowerPoint

substitutes fonts when the fonts you used are not loaded

on the new computer. Unfortunately, the software

doesn't alert you when it makes the substitutions. Font

substitutions may cause text to wrap differentiy, possi-

bly causing the information to run off the page.

When working on a PowerPoint presentation, be sure

to load all fonts onto any new computer you load the

presentation on. Also, whenever you receive a presenta-

tion from someone, you will need to know what fonts

they used and load them onto your computer if they are

not installed. If you are not sure, check the fonts folder

located in the control panel. (Start
|
Settings

|
Control

Panel
|
Fonts)

Finally, view the presentation slide by slide on the new

computer to ensure that all of the text wraps, fonts, and

graphics are displayed the way you intended.

Embedding Fonts

Embedding fonts is another way of making sure text

displays correcdy on another computer. To embed
fonts in a presentation, click File

|
Save As, Select Em-

bed TrueType check box to the right of the screen.

Note: You can embed any TrueType font that comes

with Windows. Other TrueType fonts can be embed-

ded only if they have no license restrictions. If a font

can't be embedded— for example, it's not marked as

being editable or installable— an alert appears to tell

you why. Saving a presentation with embedded fonts

dramatically increases the file size of your presentation.

Converting Freelance

Presentations to PowerPoint

In theory, Lotus Freelance presentations convert to

PowerPoint. I have converted several with mixed results.

If you used a standard Freelance template and you've

done nothing out of the ordinary, it will convert fairly

well but it puts the master on every slide. This creates a

huge file. You can paste the template to the master and

delete it from the individual slides. You will also have to

tweak the fonts, place holders and several other details.

On presentations where you have created your own back-

ground and had 'out of the design' artwork and slides.

you may find it easier to open Freelance and PowerPoint

and cut and paste between them. The conversion

process works, but it's far from transparent.

Presentation Designs and Bacl<grounds

Last month we made font changes to the master, changed

the background color, and added artwork in the form

of a watermark. But, what if none of the preformatted

designs and backgrounds works? Then we create one.

We're still using the background from last month. That

was a two color (white and light teal) gradient. Open the

presentation, choose View Master.

Select the telephone artwork used as a watermark and

resize to 2". Move it to the front using the Draw
|
Order

menu. Now cut and paste three more. Move one to the

top left of the Text placeholder. The text placeholder is

the large box in the middle of the slide that designates

where the body text of the slide will be. Move another

to the top right. Select all four and then using

Draw
I

Align align at Top. Distribute horizontally. While

all four are still selected, use Draw
|
Group. Cut and paste

the group and move the second group to the bottom of

the placeholder. Align the second group to the first and

then select both groups and move them to the back.

Let's go back to the original telephone we inserted from

the Clip Art library. Insert
|
Picture

|
Clip Art. ScroU

down to Communication and select the Top View Tele-

phone. Grab the bottom right handle and resize the art

to approximately 1.75" and then move it to the upper

left part of the screen. Align it left to the Text place-

holder and to the top of the

Tide placeholder. Click on

the Title placeholder and

drag the left margin to the

right enough to leave room

for our telephone art. Align

the text in the tide to left

justified. Close the Master.

Your slide design now fits

your subject.

Wh.ll Voice Mail Does

Lets callers know your schedule

Lets callers leave detailed messages

• Frees up receptionist

- 24-hour message center

• Retrieve messages from anywhere

- Messages are kept confidential

Next month we'U work on production short cuts.

For more information on this article contact Trapper

Badovinac of the Policy, Development & Customer

Relations Bureau at 444-4917, ZIP!/Oudook or e-mail

at tbadovinac@state.mt.us. For user support, contact the

Customer Support Center at 444-2000.
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Outlook - Add Fields to Contacts

You may have a need to list multiple fields for individu-

als in your Oudook Contact list. Say for example, some

of your e-mail contacts have multiple business phone

numbers. Even though you have filled in all of the

information for the individual and saved it, you may not

see the additional fields displayed. Here are the steps to

view those additional fields as defined in the Oudook

98 online help.

1. Click Contacts.

2. On the View menu, point to Current View, and then

click Customize Current View.

3. Click Fields.

4. In the Available Fields box, click the field you want

to add. If the field you want is not in the Available

Fields box, click a different field set in the Select

Available Fields from box.

5. CUck Add.

6. Click OK twice to close out of the View options.

I

Mouse, Mickey

: Business: (123)456-7890

! E-mail: mmouse®state. mt.us

I Mouse, Mickey

i Business: (123) «Sb-7S90

• Business 2; (123) •156-7899 8»t 876

;E-i»iail: mmouse®5tate.mt.us

For example, Mickey Mouse actually has two business

numbers. However, only otie of them is displayed. There

is no other indication that Mickey has a second number.

After applying the steps to change the view, both of

Mickey's numbers are displayed.

If you have questions regarding this article please con-

tact Sue Skuledch of End User Systems Support at

444-1392, ZIP!/Outlook, or e-mail at sskuledch@

state.mt.us.

Using correct filename

extensions

Do you invent your own filename extensions when cre-

ating files? (The filename extension is the 3-character

suffix of a filename - i.e. the part after the period). For

example, have you named an approval letter

"APPROVE.LTR"? Or your October status report

"STATUS.OCT"?

You should a/ways use the correct filename extension

for any file you are saving on your PC or file server.

What is the correct filename extension?

WordPerfect

Word
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Since .LTR isn't associated with any particular soft-

ware, Outlook doesn't know what program to use

to open it (Is it a Word document? WordPerfect

document?). Your only choice at that point is to save

the file to disk, then start the correct program (if

you know it), then open the file and read it, and

finally delete the file when you're done. This is far

too much work!

The correct software extension allows Oudook to make

the association with the correct program and the file

can then be opened by double clicking.

Let's start changing some of those old habits and use

the correct filename extensions!

For more information concerning this article, contact

Irvin Vavruska of End User Systems Support at

444-6870, ZIP!/Oudook or via e-mail, at ivavruska(^

state.mt.us.

Reveal Codes

Getting Your Job Done Without Them
There are three basic functions that "reveal codes" is

used for: understanding formatting in your document,

copying formatting from one part of your document to

another part of your document, and troubleshooting

your document formatting. This section discusses how
Word can help you address each of these tasks easily.

Revealing Formats

Word lets you view the paragraph and character format-

ting quickly and easily. To use Word's reveal format fea-

ture, click What's This? on the Help menu or press

SHIFT+Fl. When the cursor becomes a question mark,

click the text you want to check. Word details the for-

matting for everything you click. When you finish check-

ing your text, press ESC.

Word also has tools that help you find and replace or

remove specific formatting in your document.

1

.

On the Edit menu, click Find.

2. If you don't see the Format button, click More. To

search for text with specific formatting, enter the

text in the Find what box. To search for specific

formatting only, delete any text in the Find what

box.

3. Click Format, and then select the formats you want.

4. Click Find. If you want to clear the specified for-

matting, click No Formatting. Word also lets the user

find and remove text or character formatting.

5. On the Edit menu, click Replace.

6. If you don't see Format, click More.

7. To search for text only, enter the text in the Find

what box.

8. To search for text with specific formatting, enter

the text in the Find what box. Click Format, and

then select the formats you want.

9. To search for specific formatting only, delete any

text in the Find what box. Click Format, and then

select the formats you want.

10. To remove text, delete any text in the Replace with

box. To remove the specified character formatting,

click Format, click Font, and then select the

opposite format (for example, Not Bold or No
Underline).

11. Click Find Next, Replace, or All.

If you have any questions about this article, contact Mike

Moller of End User Systems Support at 444-9505, ZIP!/

Oudook or e-mail at mmoller@state.mt.us. For support

on Word 97, contact the ISD Customer Support Center

at 444-2000.
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Revealing Formate

Word lets you view ihi paragraph and character form alting in away that is

actually much easier Vinderstard and in greater depth than reveal codes To

use Word's reveal fr- \'-- -- "- ' ••-'- '^'-'' " '-- >•"---

This' on the Help n Paragraph Fomnattlng

mouse to click oml

I
everything you click

press ESC

Word also ha$ tools

docunneni

] rintho PrI.I

Paragraph style: Inderal left -0.2S" Flush Isft, Space before 6 pt ^erSpC,
Koop with nejtt, SLpprsss ine nurfilws, Dont hyphenate, Level 2

Direct:

Font Formatting

Paragraph Style Ftjnt; Arialj M pi, Bold, English (Unit«d 5t«w)

Charaftei" style;

Direct:
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Here's a timesaving technique for printing more than

one copy of an envelope.

If you've used Word's envelopes and labels feature,

you've probably noticed something—you can print only

one envelope at a time. But what if you need multiple

copies of an envelope? Repeatedly opening the Enve-

lopes and Labels dialog box and entering the address

information is one approach. In fact, it may be the only

method that comes to mind, since the technique for

printing multiple copies of an envelope isn't exacdy

obvious. There's no option you can select in the Enve-

lopes and Labels dialog box to print multiple envelopes.

Instead, you have to use the Pages option in the Print

dialog box when you want to print more than one copy

of an envelope. It isn't intuitive, but it's also not rocket

science. Let's illustrate the technique with an example.

Suppose you want to print three copies of an envelope.

Begin by choosing the Envelopes and Labels command

from the Tools menu. Then, if necessary, click the

Envelopes tab.

Enter the desired delivery and return address informa-

tion and click the Add to Document button.

Once you've added the address information to your

document, choose the Print command from the File

menu (ctrl P). In the Print dialog box, click in the Cop-

ies text box (if necessary) and type 3. Then, select the

Pages option in the Page Range area and type 0.

Now you're ready to print. Click OK and insert the

envelopes in your printer when prompted. After print-

ing, choose Close from the File menu and clickNO when

asked whether you want to save changes.
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PC TALK

Web Pages - How to keep yours from being indexed

In a previous article (November 1997) we started detail-

ing how to make your web pages more accessible to

search engines. This article details how to make your

pages invisible to search engines. ^X'hy would we encour-

age you to optimize your pages for web searches and

then give you instructions on how to avoid it?

One reason to keep pages from being indexed would be

that if you have one that is constandy changing which

could result in stale information being kept in the index

long after the page has changed. This is frequendy a prob-

lem with the large web search engines because it takes

them so long to return to a site once it has been indexed.

Another reason might be to keep more sensitive infor-

mation out of the Search Engine. Using these techniques

for this reason has to bring up the question of why the

information is on the server to begin with. A search en-

gine doesn't know what is sensitive and what is not, it

just follows links.

Perhaps you have a newer page that you want people to

start using but you can't delete the old page yet. Index-

ing only the new page will help the migration.

The exact reasons for excluding a web page will depend

on your needs. You may not even need this capability at

aU, but it is nice to know what is available.

The most common way to exclude your pages is to use a

robots.txt file that instructs the search engine's robot,

crawler, spider, agent (etc.) to leave certain pages alone.

You can even specify that certain robots are not allowed

while others are. This might be useful if a particular ro-

bot was causing your sever problems for some reason.

The problem is (you knew there had to be a problem)

that not all robots will honor these commands. Most do,

however, so it is worth the effort if needed.

Details on the robots.txt file commands can be found

at: http://info.webcrawler.com/mak/projects/

robots/exclusion-admin.html

A quick example:

To exclude all robots from part of the server

User-agent: *

Disallow: /cgi-bin/

Disallow: /tmp/

Disallow: /private/

There is also another way to exclude a page from index-

ing, the Robots META tag. The Robots META tag

allows HTML authors to indicate to visiting robots if a

document may be indexed, or used to harvest more links.

No server administrator action is required. Note that

currentiy only a few robots implement this.

In this simple example:

<META NAME="ROBOTS" CONTENT="
NOINDEX, NOFOLLOW">

A robot should neither index this document, nor

analyze it for links. Full details on how this tag works is

provided:

http://info.webcrawler.com/mak/projects/robots

/meta-user.html

The new Montana Online search engine only indexes

the web sites within State Government. This is a great

help in locating information wherever it may exist within

the many agency servers as well as the Montana Online

server itself. The search engine is configured to revisit

indexed pages each night so stale data won't appear in

the index, unless your page changes several times during

the day. It will also allow you to view only pages that

have been created/updated within the previous day, week

or month.

We will have more complete details about the Montana

Online Search Engine in an upcoming article.

For more information contact Ron 7\rmstrong of the

Systems Support Bureau at 444-2905, ZIP!/Outiook or

e-mail at rarmstrong(§ state.mt.us.

to

5
>
ces

in

o
to



I K A 1 IN 1 IN (J

o
>
08

I/)

5

1/5

Tips & Tricks

Dragging Code Modules Between MS
Office Application Projects

Sharing code between Visual Basic projects in Microsoft

Office is easier than ever with the Visual Basic Editor.

Now you can drag modules between projects. For

example File Save Modules, and User Input Prompt

Modules. Try the following:

1

.

Open Microsoft Word and Microsoft Excel.

2. In each application, press ALT+Fll to open the

Visual Basic Editor so that you're running two sepa-

rate instances of Visual Basic Editor.

3. In each instance of Visual Basic Editor, if Project

Explorer is not open, press CTRL+R to open it

4. In one instance of Visual Basic Editor (either one),

click Class Module on the Insert menu. Set the

Name property of the class module to clsOne.

5. In the other instance of Visual Basic Editor, select

Module on the Insert menu. Set the Name prop-

erty of the standard module to modOne.

6. Drag the class module from Project Explorer in the

first instance of Visual Basic Editor to Project Ex-

plorer in the other instance of Visual Basic Editor.

Both projects now have a copy of the class module.

7. Drag the standard module from Project Explorer in

the second instance ofVisual Basic Editor to Project

Explorer in the first instance of Visual Basic Edi-

tor. Both projects now have a copy of the standard

module.

For more information about this article contact Jerry

Kozak of End User Systems Support at 444-2907, ZIP!/

Outlook or e-mail at jkozak@state.mt.us. For support

on Microsoft applications, contact the ISD Customer

Support Center at 444-2000.

Media Based Training (MBT)

Databases are used frequendy to solve a myriad of prob-

lems. Relational databases (RDBS) can take the data and

report it back to give you only the specific data you re-

quest. Designing and building relational databases is a

very worthwhile skill to have. This month we'll review

the courses that deal with RDBS.

A VCR or Multi-Media PC is needed. Most of the

courses are delivered on video as well as multi-media

CD, some are only available on CD ROM. The infor-

mation is presented in a very professional manner using

various teaching methods including diagrams and real

life examples. The accompanying workbook provides

the course in written form and after each section quiz-

zes you on what has been covered.

Sign up. Contact Shawndelle Semans at 444-2700, ZIP!/

Oudook or e-mail at ssemans@state.mt.us. She will need

your name, phone number, address. Agency and how
you like to receive the course. See below.

How do I get the course? You can pick up the course

in Room 222 of the Mitchell Building. It can be dead-

headed (interoffice mail) or mailed to you.

How Long? The checkout period for each course is

two weeks. If you can't complete the course in two weeks

and if there is no one on the waiting list, we can usually

extend the checkout period for another two weeks.

What's Available? The course description of each

course can be found on the VAS at guest\training\

CT_Video\T3_VAS.rtf. If you are an Approach user

you can check on the current availability of any course

by accessing the read-only file on the VAS at

guest\training\CT_Video\videodb.apr (password

Montana).

How Much? There is no charge.

Who is eligible?

Any state employee.

Need Training?



TRAINING

Understanding Relational Databases

This course is an online tutorial that teaches you the

theoretical basis of relational database management sys-

tems. This tutorial presents information on screen and

reinforces your knowledge with graphic representations

of concepts and exercises.

Second, you use SQL through a workshop facility. This

workshop consists of a workbook containing exercises

which you complete using ORACLE'S SLQ*Plus. Ad-

vanced SQL*Plus is designed to be linked to ORACLE
for PC/MS-DOS and the results shown in workbook

are based on ORACLE.

Intro to Relational Databases and SQL Application Programming with PRO*C?

This course is an online tutorial that teaches you the

basic concepts of relational database management sys-

tems and why they are becoming the dominant database

technology. It also teaches you the Standard Query Lan-

guage (SQL) used to extract information from relational

databases. This tutorial presents information on screen

and reinforces your knowledge with graphic representa-

tions of concepts and exercises.

Logical Database Design

This covirse is an online tutorial that teaches you the

theoretical basis of relational database management sys-

tems. This tutorial presents information on screen and

reinforces your knowledge with graphic representations

of concepts and exercises.

Using SQL*PLUS

This training course teaches you to use Structured Query

Language (SQL) in tu'o ways.

First there is an online tutorial. This tutorial presents

information on SQL, simulates actual SQL queries, and

reinforces your knowledge with exercises. Second, you

use SQL through a workshop facility. This workshop

consists of a workbook containing exercises which you

complete using ORACLE'S SLQ*Plus.

Using SQL*Plus is designed to be linked to ORACLE
for PC/MS-DOS and the results shown in workbook

are based on ORACLE.

Advanced SQL*PLUS

This training course teaches you to use Structured Query

Language (SQL) in two ways.

First there is an online tutorial. This mtorial presents

information on SQL, simulates actual SQL queries, and

reinforces your knowledge with exercises.

This course is an online tutorial that teaches you to em-

bed SQL statements in other programming languages.

The examples in the course are taken from the ORACLE
RDBMS and use the C programming language. How-

ever, the same concepts apply to other relational data-

base such as DB2 which use a precompiler to process

SQL statements before the host-language compiler is

run.

Oracle Student Assessment Module

This module tests smdent knowledge of Relational Da-

tabases and SQL. It is designed to be used both as a self-

placement tool and a mastery assessment program for

all courses in the ORACLE library.

Every pre-test and post-test is unique because questions

are chosen at random from a group linked to each learn-

ing objective. A separate score is recorded for each les-

son. Types of questions that include multiple-choice and

fiU-in-the-blank and true/ false, thoroughly cover the

material presented in the nine courses. Reports are pro-

vided to print results for individual students or all stu-

dents.

The questions in this assessment module are taken from

material presented in the foUowing courses:

Course 1: Intro to Relational Databases and SQL
Course 2: Using SQL*Plus

Course 3: Advanced SQL*Plus

Course 4: Application Programming with Pro*C

Course 5: Understanding Relational Databases

Course 6: Data Modelling

Course 7: Using SQL*Forms 3.0

Course 8: Programming with PL/SQL

Course 9: Using SQL*ReportWriter 1.1

For more information contact Trapper Bado\'inac of

the Policy, Development & Customer Relations Bureau

at 444-4917, ZIP! or e-mail at tbadovinac@state.mt.us.
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Six Months Left!

Oracle will discontinue the Oracle Channel satellite

broadcast education program on May 31, 1999. Please

watch the schedule carefully and plan your training

accordingly.

December

1 Financial Applications Release 1 1 New Features

2 Manufacturing Applications Release 1 1 New
Features NEW

3 Discoverer3: Analyze Your Data Requirements

8 SQL 1: Retrieve Data

9 SQL 11: Define and Manipulate Data

10 SQL Statement Tuning

1

5

OracleS Data and Security Management

16 OracleS Backup and Recovery Strategies

17 OracleS Performance Tuning Strategies

22 Designer/2000 Release 2 New Features

23 Designer/2000: Generate Oracle WebServer

Applications

January

5 PL/SQL 1: Coding Techniques

6 PL/SQL 11: Database Level Application

Programming

PL/SQLS New Feamres

OracleV Introduction to Oracle

Certification Primer NEW
Oracle? Database Administration

Certification Primer

OracleV Backup and Recovery Certification

Primer NEW
OracleV Performance Tuning Certification Primer

14 Using OracleS Replication

19 OracleS Architecture and Starmp

20 OracleS 7\rchitecture and Starmp

21 OracleS Networking Strategies

26 Introduction to Data Warehousing

2V Planning for a Successflil Data Warehouse

28 Data Warehousing Fundamentals for DBAs

7

12

13

February

2 Financial Applications Release 1 1 New Feamres

3 Manufacmring Applications Release 1

1

New Feamres

4 Object Technology Essentials

9 Developer/2000 Release 2 New Feamres

10 Developer/2000 Tuning

1

1

Introduction to Oracle Web Application Server

16 OracleS Data and Security Management

17 OracleS Backup and Recovery Strategies

1

8

OracleS Performance Tuning Strategies

23 OracleV Introduction to Oracle

Certification Primer

OracleV Database Administration

Certification Primer

24 OracleV Backup and Recovery

Certification Primer

OracleV Performance Tuning Certification Primer

25 Discoverer 3: Analyze Your Data Requirements

A fiill description for the each of the classes can be found

on the Oracle website at http://education.oracle,

com/education/toc. Because class material has to be

ordered you must register at least two weeks before the

scheduled class date. Please contact Barbara Clark at 444-

0846, ZIP!/Outiook or e-mail at baclark@state.mt.us.

End Users Computer

Security Training

This is a two-hour seminar

that covers the following:

network security

laws, rules, and policies

login IDs and passwords

viruses, hoaxes, and chain letters

proper use of e-mail and the Internet

user responsibilities

The training is held the third Thursday of each month.

Date: Thursday, December 17

Time: 8:30-10:30 am
Location: Room 13, Mitchell Bidg.

For registration or more information, please contact

Lois Lebahn (llebahn@state.mt.us) or Kim LaRowe

(klarowe@state.mt.us) of ISD at 444-2V00.



TRAINING

New Look for Microsoft 97 Courses

The Helena College of Technology has revamped their

curriculum for the non-credit Microsoft 97 workshops

offered through state training. This change will start

in January. (See State Training Schedule). Below is the

course names and topics to be covered.

Introduction to Word 97

Prerequisites: Windows 95 or instructor consent

Topics:Page layout, navigation techniques, basic format-

ting, spell check, AutoCorrect, envelopes, bullets, edit-

ing text, help, templates (not designing), printing, sav-

ing, opening documents using basic file management.

Intermediate Word 97

Prerequisites: Intro to Word 97 or instructor consent

Topics:Merges, labels, page numbering, borders, water-

marks, tables, tab indents, columns, outline, header &
footers, water marks, designing tool bars and recording

macros.

Advanced Word 97

Prerequisites: Inter. Word 97 or instructor consent

Topics:Designing templates, macros using Visual Ba-

sic, and customizing menus

Word 97 or Excel 97 Conversion

Prerequisites: Windows 95. Previous Spreadsheet or

Word Processing experience.

Description: This course is designed for the experienced

WordPerfect and/or Lotus user who wants an overview

of the Microsoft 97 products.

Introduction to Excel 97

Prerequisites: Windows 95 or instructor consent

Topics:Screen layout (menus, worksheet, workbooks),

text vs. numeric, navigation techniques, basic format-

ting, editing cells, basic formulas, cell referencing,

AutoFill, saving, printing, opening documents, using

basic file management, graphs, data filters, and text wrap.

Intermediate Excel 97

Prerequisites: Intro to Excel 97 or instructor consent

Topics:3-D pages, name ranges, IF statements, func-

tions, Lookups, recording macros, linking, importing

external data.

Advanced Excel 97

Prerequisites: Inter. Excel 97 or consent of instructor

Topics:Macros using Visual Basic

6
5
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Training Caiendar

Schedule assembled by the Helena College of Technology of the University of

Montana. If you have any questions about enrollment, please call 406-444-6821.

All classes are held at HCT, 1115 N. Roberts.

The Helena College of Technology will make reasonable accommodations for any

disability that may interfere with a person's ability to participate in training.

Persons needing an accommodation must notify the college no later than two weeks

before the date of training to allow adequate time to make needed arrangements.

To make your request known, call 444-6821.

To enroll in a class, you must send or deadhead an enrollment appli-

cation to State Training Center, HCT, Helena, MT 5960. If you have

questions about enrollment, please call 444-6821.

Once you enroll in a class, the full fee will be charged UNLESS you

cancel at least three business days before the first day of class. HCT is

also willing to schedule specific classes by request from state agencies.
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State Training Enroiiment Application

Complete IN FULL and return AT LEAST ONE WEEK prior to the first day of class.

Course Data

Course Request_

Date Offered

Student Data

Name

See. Sec. Number (for P/P/P)

Agency & Division

Mailing Address

Phone

I/)

5

How have you met the required prerequisites for this course? Explain, giving the class(s) ^n

taken, tutorial completed, and/or experience. ^
Q
1/1

Billing Information/Authorization Mandatory

LogonID Agency* Authorized Signature

If attending Oracle Developer or Designer training, your application must also be approved by

the agency IT Manager.

IT Manager

.

Training is needed for

Agency Oracle Developer

Continuing education opportunity (Agency will be billed for training.)

Agency contractor (Agency will be billed for training.)

Full class fee will be billed to registrant unless cancellation is

made three business days before the start date of the class.

DeadHead completed form to

state Training Center, Helena College of Technology of the U of M

Phone 444-6800 FAX 444-6892
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